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Appendix 12: MCU COMPUTER AND DIGITAL OPERATIONS 
 
Turn On Procedures  
 
Before turning any of the computers on, first be sure the generator has been turned on 
long enough to warm up and settle down. The Power Frequency Meter should stabilize 
around 60 Hz +/-.  We want the generator to run smoothly before firing up the 
computers.   
 
Log-On 
 
Once booted, you will be required to sign on.  The basic sign-on screen asks for a 
username and a password.  The common username and password are located on the 
keyboard and subject to security updates. 
 
Log-Off/Shutdown 
 
When operations are complete, the computers should always be shut down properly 
(files saved / closed / forwarded via required /  programs exited).  Please ensure that 
you Log Off and Shutdown before turning off the generator. 
 
Any problems with the computers should be reported to Bob Hollister (N7INK) or Lee 
Ilse (K7OED) as soon as possible to ensure that maintenance issues can be addressed 
prior to the next mission.  Write down any error messages encountered as completely 
as possible to aid in troubleshooting.   
 
General Information 
 
The MCU is equipped with four computers to support a variety of tasks:  

• Creating/maintaining the mission communications log (ICS 309), 

• Creating/Maintaining the Unit Activity Log (ICS 214) 

• Control of the Audio Control Unit (ACU) -2000,  

• ACU radio programming, 

• Map support, (SAR Topo, TopoUSA (on W7 Computer)) 

• Digital operations (APRS, PACTOR, VARA and Packet), 

• Internet Connectivity, 

• Control of the Mast Camera.   
 

They are loaded with software including MS Office 365 (MS-Word, MS-Excel, MS-
Access), and Notepad for ASCII text.  During normal operations the ACU/Mission 
Support laptop is used primarily for maintaining the Communications Log (ICS Form 
309), Internet (email via Gmail account) connectivity and for ACU support if required. 
This the laptop closest to the Desktop Public Safety Radios (Motorola 7500 on wall and 
Tait TM9100 on desktop). The Mapping Operations laptop is used to track location of 
deployed resources, operate the camera, and display products on the front flat screen 
monitor.  Digital Operations Computer (DOC) also has SARTOPO installed and located 
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on the curbside of the shelter.  The Wi-Fi router on the MCU local area network to can 
also provide connectivity for external customers (SAR team command van, etc.).  Each 
computer will be discussed separately and in more detail below.   
 
ACU/Mission Support Computer (MCU #1) 
 
The ACU/Mission Support Computer is a Dell laptop with Windows 11 installed that is 
stored in its case in the street side overhead compartment for security and basic 
physical protection during travel. This laptop should be plugged into one of the network 
connections with a Cat 5 Network cable and to the AC power adapter before operation.  
 
Communication Log 
 
As mentioned in Appendix 11, perhaps the single most important and common form 
used by all operators is the ICS Form 309 (Communications Log). One of the first tasks 
upon arriving on the scene of the incident or mission is establishing a log of the 
communications activity.  Using the MS Word program, open the ICS Form 309 
template. Immediately save and rename the template file to avoid overwriting the Blank 
Template. The file naming convention is: Mission Date (year-month-date), Mission 
Name. Here is an example: 2025-01-25-TurkeyCreek Search Comm Log.docx 
If it is a SAR mission, save it in the SAR Mission Log Folder on the computer or other 
appropriate folder for other type missions. Sample of blank template below: 
 

COMMUNICATIONS LOG Task #  
DATE PREPARED: 

TIME PREPARED: 
FOR OPERATIONAL PERIOD # Task Name:  

RADIO OPERATOR NAME: STATION ID:  

LOG 

TIME 
STATION I.D. 

Subject / Activity 
FROM TO 

    

    

 
DATE PREPARED: Self Explanatory 
TASK #: This will generally be the mission number assigned.  You don’t always have 
this at the time you create the log. Check with the Incident Commander. 
TIME PREPARED: Time Log Opened / Established 
FOR OPERATIONAL PERIOD #: Identifies which operation period this log is for. On 
short missions it may only be one.  If a second or additional periods are required, 
identify which log this is for. 
TASK NAME: The title assigned by the Incident Commander to the incident or mission. 
RADIO OPERATOR NAME: Name or names filling out the log. e.g. (Ilse R50/ 
Yarbrough R119, Hollister R70) 
STATION ID: Usually, MCU 
TIME: Current local time of the conversation/activity being logged 
STATION ID    
 FROM: ID or callsign of station initiating the call 
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 TO: ID or callsign of station or stations being called 
SUBJECT / ACTIVITY: A Gist or Transcript of the conversation. A Gist is an edited 
version of the conversation, whereas a transcript is a word for word record of what was 
said.  A Gist is more common but some things like grid coordinates, names, key points 
should be a complete transcript. 
We should log, not only the conversations between stations calling the command center 
but also capturing details of all other conversations and events overheard on the 
channel between other stations. At least two operators should be working together on 
these logs in the MCU and comparing notes to ensure accuracy and completeness.  If 
there are other operators or monitoring locations such as Home Units and maintaining 
communications logs we should compare notes after the event is complete before we 
turn our paperwork into the Incident Commander.  We have these forms on all three 
computers in the MCU. Depending on your typing skills, it is frequently easier to make a 
hand log first and then type the information onto the computer form when there is a 
break in the action. When mission is complete, be sure to save the log and send it to the 
RACES Officer (lee.ilse.az@gmail.com) or to n7ink@cox.net. We like to perform a 
quality check before submitting it to the Incident Commander of the mission. You can 
practice your logging skills on a regular basis by just listening to some of the law 
enforcement channels periodically during their responses to accident scenes or other 
emergencies.  Amateur contesting is also good practice for developing these critical 
listening skills. 
 
Mapping Operations Computer (MCU #2) 
 
This laptop computer is stored on the street side overhead compartment and setup on 
the operating bench near the rear street side of the MCU. The primary software used is 
called SARTOPO. This program allows the Command Post to track our SAR Teams as 
they conduct operations in the field. The MCU, members of the Command staff or SAR 
Team to post clues/sign as they maneuver around the search area. Those tracks or 
clues are shared automatically across the network (computers and mobile phones) as 
long as our Wi-Fi and the Starlink 
satellite links are functioning correctly. 
The techniques using SARTopo are best 
learned as an “On the Job Training” 
(OJT) and practice during a mission or 
training activity.  The large screen 
monitor located on the front wall may be 
attached using the HDMI port on the 
side of the computer. This may used for 
displaying mission products, or if 
connected to the HDMI port on the 
mapping computer displaying mapping 
products or mast camera output. 
 
Digital Operations Computer (MCU #3) 
 

mailto:lee.ilse.az@gmail.com
mailto:n7ink@cox.net
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This laptop computer is stored on the curb side overhead compartment and setup on 
the operating bench curb side near the rear of the MCU next to the IC-7300 radio.  
An additional flat screen monitor is affixed to the wall 
with security screws.   

Digital Software - This computer is also 
configured to operate VHF APRS with the Yaesu FT-
2600 radio and KAM Terminal Node Controller (TNC).  It 
is also used with the ICOM IC 7300 HF radio and SCS 
PTC PACTOR TNC for other over-the-air digital 
operations.  

Mapping Software – We currently have installed 
SARTopo. The best way to learn this application is a 
one-on-one session with a more experienced operator. 
 
MCU iPad 
  
The iPad is used primarily for control of the mast camera. It is stored in the cabinet 
above the Motorola APX 7500 Public Service Radio. It is an Apple device and uses the 
same controls/motions you would on our Apple cell phone.  
 
To turn on iPad – When looking at the screen, the power button is on the upper right 
side, press and hold about 4-5 seconds, the Apple Logo will appear on the screen 
during the boot process.  The Logon PIN is written down on the inside cover of the MCU 
Service record black book stored on wall under clock.  Once you have it turned on, be 
sure you are connected to MCU Wi-Fi. 
 
To turn the iPad off, it is similar to the iPhone, press Lower Volume button and power 
button on upper right side of the unit simultaneously, a “Slide to power off” window will 
pop-up at the top of the screen. 
 
The iPad can also be used to access a wide variety of Internet resources.  
 
Mast Camera Operations 
  
The camera installed on the pneumatic mast is made by Sony.  The mast should be 
deployed at least 10 ft up to use the camera. It is live on the local area network 
whenever the AC power is active. The preferred method for controlling the 
camera is via the iPad. To access the mast camera on the iPad you must go 
through the Internet using the “SAFARI” application (Compass logo):  On the 
iPad you have an active touchscreen for controls. On the laptop you will use 
the touchpad or mouse for control. If needed, the IP address for the camera is: 
192.168.1.2.  To close camera window, slide up from bottom. 
  
There is a shortcut on the laptop computers “desktop” that allows direct access. If you 
have difficulty accessing the camera, you may have to shut both computers down and 
reboot them. There may be a short delay as the camera is accessed over the network 
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and another popup menu with several options comes up.  Select "ActiveX Viewer".  The 
camera view will now appear on the screen.  To control the camera view and 
manipulate it, select the "Control" icon. You will now be able to move the camera 
up/down, right/left, and zoom in/out using various controls.  The current camera gives 
you the ability to rotate 360 degrees, unlike the older camera, there is no "Stop" 
prohibiting continuous left to right or right to left in the direction of the mast.  And since 
the camera is physically mounted below the top of the mast, there is also a blind spot 
trying to look through the mast itself.  You will need to consider that when parking the 
MCU and the direction of the primary incident from the vehicle.  In other words, don't 
point the front of the truck directly at the incident.  
 
Video Capture 
 
To capture video as a still for transmission (email), select the "Capture" icon. A 
thumbnail of the shot will appear on the screen.  If that is what you want, right click the 
mouse to save the photo as a JPG file.  You will now be able to attach that JPG and 
send it as an email attachment using the MCU Gmail account. Videos are of such size 
that they can usually NOT be sent via email. In the event that the laptop has trouble 
controlling the camera, you can access the camera with the iPad using the internet 
address on the white board. You may also access the camera on your personal mobile 
phone using the internet address posted on the white board. 
 
Audio Control Unit (ACU) 2000 Operations 
 
As might be imagined from its title, the secondary function for this computer is providing 
computer control of the ACU-2000. The ACU is a communications linking/bridging 
device used to allow communication between remote users who are using different 
types of communication devices, such as radios with different frequencies and/or 
modes. For example, the ACU can be used to enable communication between VHF 
radios in FM or P25 Digital Voice mode and HF radios in SSB mode or between radios 
and telephones, either in the public telephone system or local phones. Transmitting and 
receiving by the ACU are performed by physically attached communication devices 
(radios, phones, etc.). The ACU’s function is simply to pass audio signals from the 
receiving device to the other linked devices which then retransmit the signals. For 
example, one attached radio might be set to a police frequency while another might be 
set to a fire department frequency. This would allow personnel on the two disparate 
frequencies to communicate with each other. Another example would be the linking of 
Forest Service, Department of Public Safety, National Guard and State Emergency 
Services communications.  The ACU may also be attached to the public telephone 
network when available and to local phones to allow phone users to call or be called by 
radio users.  Link (net) control is performed primarily by the ACU control operator. 
However, links and phone patching may be carried out by remote users without the 
involvement of the control operator. Whereas the control operator may use either a 
computer (i.e. laptop) or the ACU’s keypad, remote users are restricted to DTMF 
(keypad) use only. Currently the ACU is equipped with 4 VHF, 2 UHF, and 2 700/800 
trunked radios. 
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Operations carried out by the control operator fall 
into two general categories: those carried out 
prior to use of the ACU in normal operations (e.g. 
setup) and those carried out during normal 
linking operations. Both types of operations are 
usually performed through the use of a laptop 
computer attached to the ACU. Before describing 
these operations, this guide will first discuss the 
screen display which the operator will be working 
with as the functions are performed.  
 
Once you turn on the computer and it is booted 
up, Log On using the username and passwords 
on the computer. 
 
The Windows screen contains a menu (or task) bar at the top with the names of the 
various dropdown menus (i.e. File, Options, etc.). The body of the screen is black and 
has seven horizontal light green lines, spaced so that the bottom line is near the bottom 
of the screen. These are Net Lines. The left margin of the screen shows the Net 
Number to the left of each Net Line. Above the top net line is another such line called 
the Idle Line.  Along the idle line are icons arranged representing the LP-1 module and 
the other interface modules present in the module cage.  
 
Above each icon is the module’s slot number (00-12), referred to as the Module 
Number. An empty slot is represented by a blank space where the module’s icon would 
appear. Each icon bears the module type name at the top (e.g. DSP-1). When modules 
are connected (linked), their icons drop to a net line. All icons placed on a given net line 
represent a net. Those on a different net line represent a separate net and may not 
communicate with those not on their net line (unless via a Priority Net).  
 
Module Settings  
 
Prior to linking operations, the control operator enters settings information as necessary 
for each DSP-1 and PSTN-1 interface module. To enter a module’s settings, the 
operator double (left) clicks on the module’s icon. This causes the module’s settings 
entry screen to be displayed. The screen format (what is shown or asked for) depends 
on whether the module is a DSP-1 or PSTN-1.  As a rule, factory settings should be 
used except when necessary to improve performance.  For the purposes of this guide it 
is assumed that most set-up steps have already been completed. 
 
Operations carried out by the control operator include the following:  
- Device Connections: The linking together of two or more attached communications 

devices. Individual groups of links (nets) may be established. For example, Police 
might be linked to Fire.  

- Net Connections: The linking together of two or more nets (groups of links).  

Commented [LI1]: Need new photo 
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- Priority Nets: The linking together of external devices which have been assigned to 
different nets. These devices are then isolated from all devices not in the priority net.  

- Monitoring: Enabling one external device to receive signals from other specified 
external devices, regardless of whether they are in the same or different nets. 
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Control Operator Operations 
 
Linking Two Modules (Establishing a Net)  

1. Left click on first module (icon), on the idle line, to be linked.  
2. Left click on second module icon to be linked.  

 
Both modules will fall to the next free net line and will be linked for communication. The 
first module will not drop to the net line until the second module has been clicked.  
 
Adding another Module to a Net  

1. Left click on the icon of the module to be added to the net.  
2. Left click on the net line’s Net Number or on one of the icon’s on the line.  

The new icon will fall to that line and join the other modules in the net.  
 
Deleting a Module from the Net  

1. Right click on the module to be deleted from the net.  
The module will move back to the idle line and will no longer be linked.  
 
Deleting a Net  

1. Right click on the net line’s Net Number. Or right click on all icons in the net 
line. All icons in that net line will be unlinked and will move back to the idle line. 
 
Moving a Module to a Different Net  

1. Left click on the icon of the module to be moved.  
2. Left click on the target net line’s Net Number.  

The icon will move to the new net line. It will no longer be linked to the modules in the 
former line.  
 
Linking Nets  

1. Left click on the first net line’s Net Number.  
2. Left click on the second net line’s Net Number.  

The color of the two net lines will change to show that both nets are linked. Any module 
in the first net may communicate with any module in the second net. Up to three such 
nets can be established.  
 
Adding Another Net to Linked Nets  

1. Left click on the Net Number of the net to be added to the link.  
2. Left click on the Net Number of one of the nets already in the link.  

The color of the net line added to the link will change to the same color as that of the 
lines already in the link.  
 
Deleting a Net from Linked Nets  

1. Right click on the Net Number of the first net to be deleted.  
If only two nets were in the link. They will be unlinked and the color of their net lines will 
return to green.  
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Establishing a Priority Net  
Modules in a priority net need not be on the same net line. That is, they may be in 
different nets. Members of a priority net are isolated from all other modules. They may 
communicate with each other but cannot communicate outside that net. Likewise, other 
modules cannot communicate with those in the priority net. Priority nets are used only 
when the modules are already in established nets.  

1. Left click on a module icon that is already in a net line.  
2. Left click on the second module icon. It may be in the same or in a different net 

line.  
A small red box containing a white Priority Net Number will appear in both icons 
indicating that they are now in a priority net.  
 

Adding Modules to a Priority Net  
1. Left click on the module (icon) to be added to the priority net.  
2. Left click on a module that is already in the net.  

A small red box containing that Priority Net Number will appear in the icon of the module 
that was added.  
 
Deleting Modules from a Priority Net  

1. Right click on the icon of the module that is to be deleted from the priority net.  
The small red box within the icon will disappear showing that the module is no longer a 
part of the net.  To delete the entire priority net, right click on all but the last icon. 
 
Enabling Monitoring  
This function allows the user(s) of a module to monitor communication by one or more 
other modules. The monitoring module “hears” what the monitored modules hear. The 
monitored modules may be in different nets (net lines) and/or in the idle line. The 
monitoring module is unable to transmit to monitored modules unless they are in the 
same net (as the monitoring module) or share a priority net.  

1. For the module that will monitor, left click on the module (slot) number above 
the icon. The module numbers are above the icons on the idle line at the top of the 
screen. A green box containing an “M” will appear in the icon and the word MONITOR 
will appear vertically in the left margin of the screen.  All other icons in net lines will 
contain a black disk.  

2. For each module to be monitored, left click on the module’s icon and then left 
click on MONITOR.  That module’s number will appear in a white box along the bottom 
of the monitoring module’s icon.  

3. Continue step 2 until the module numbers of all modules to be monitored 
appear beneath the icon of The monitoring module. Monitoring links remain in force 
even if a monitored module is moved to another net or back to the idle line where it is no 
longer linked to any other module. To enable monitoring for another module, repeat 
steps 1-3 for the new module. 
  
Ending Monitoring  

1. Repeat the same steps that were performed to enable monitoring but right 
click on MONITOR (see step 2).  
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Establishing a Phone Patch  
This function involves the control operator establishing communication with another 
person via the public telephone network. The MCU needs to be connected via cable to 
the PSTN or by satellite using the Starlink Voice Over Internet Protocol (VOIP) system. 
The operator connects (links) from HSP-2 module to the PSTN-1 phone system module, 
dials the remote user’s phone number and establishes communication with the remote 
user. At this time, the operator may also add other modules (radio and/or local phone) 
to the link. When communication is ended, the operator ensures that the PTSN-1 link is 
terminated and that all other modules are unlinked.  

1. Left click on module 00 (HSP-2) icon.  
2. Left click on the PSTN-1 module’s icon. The phone number entry screen is 

displayed.  
3. Enter the telephone number.  
4. Left click on DIAL.  The ACU 2000 dials the phone number.  
5. Communicate with the remote user. Advise him/her that each “transmission” 

should be ended with OVER to avoid confusion and that he/she should press *# before 
hanging up (this will disconnect the PSTN-1).  

6. If the called person neglects to transmit *# before hanging up, the PSTN-1 
module will remain linked.  If this occurs, right click on the PSTN-1 module’s icon to 
disconnect it.  If other modules are added to the link, the control operator may enable 
monitoring by the HSP-2 module. 
 
Other ACU Operator Control Options 
 
There may be instances where power to the ACU 2000 is interrupted or where the 
laptop computer is inadvertently disconnected from the ACU. When this happens, the 
configuration / links may be lost. This section describes how the ACU configuration may 
be restored and how a given configuration may be saved and reloaded at a future time if 
desired.  
 
Power Lost or ACU Temporarily Powered Down  
When power is restored to the ACU 2000, the modules present in the module cage are 
recognized, but they will all appear on the idle line above the net lines.  

1. Click on the File dropdown menu at the top of the screen.  
2. Select and click on “Restore Last Config.”.  

Laptop Disconnected  
1. Click on the File dropdown menu at the top of the screen.  
2. Select and click on “Retrieve Current Config.”.  

 
Saving and Recalling Configurations   

A given configuration may be saved and recalled at a later time. However, when 
it is recalled, the module arrangement in the ACU must be the same as when the 
configuration was saved.  
 
Saving the Configuration  

1. Click on the File dropdown menu at the top of the screen.  
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2. Select and click on “Save Configuration”.  
3. When prompted, enter the save name and complete the save.  

 
Loading the Configuration  

1. Click on the File dropdown menu at the top of the screen.  
2. Select and click on “Load Configuration”.  
3. When prompted, enter the save name and complete the load.  

 
Linking all Modules  
The operator may link all modules for the purpose of making a general announcement 
(QST) or some other reason.  Afterward, this link can be terminated and the original 
configuration re-established.  

1. Click on the Options dropdown menu at the top of the screen.  
2. Select and click on “Connect All”.  
3. Carry out announcement and any necessary communication.  
4. In the Options menu, click on “Revert” (immediately below “Connect All”).  

 
Unlinking all Modules.  
The operator may terminate temporary links to carry out a control function and then 
revert to the pre-existing configuration.  
1. Click on the Options dropdown menu at the top of the screen.  
2. Select and click on “Disconnect All”.  
3. Carry out the control function(s).  
4. In the Options menu, click on “Revert” (immediately below “Disconnect All”). 
 
Amateur Contact Log (Found on Computer #3 by Icom 7300 HF station) 
The N3FJP. Amateur Contact Log is an easy to use general logging program that has 
many great features including tracking of worked all states, counties and countries.   It is 
quite easy to use and we use it regularly at Paradise, Field Day, or other contest type 
activities.  If you have used paper logs in the past, you will quickly recognize the typical 
data items that are filled in to document our contacts.  The logs can also be uploaded to 
the Internet, downloaded or printed as necessary.  
 
Once the AC Log icon is activated you will see the basic operating screen.  Fill in the 
fields on the lower part of the screen starting with the Callsign of the station worked. 
Use the <TAB> key to move to the next data element.  A copy of the QRZ callsign data 
base is linked to the software and will display the name and basic information 
associated with the callsign.  Once you have all the information and completed the 
contact, click the “Log Contact” button or the enter key and the information will be added 
to the database.  
 
AIRMAIL/PACTOR/HF Email Operations 
The software application we use to access the Amateur Winlink HF email network:  

 
WinLink Express software using PACTOR III, ARDOP, or VARA modes by radio 

or TelNet Winlink (via Starlink). 

https://www.n3fjp.com/aclog.html
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HF PACTOR operations use the ICOM IC 7300 transceiver and the Pactor III licensed 
SCS PTC-IIex terminal node controller (TNC). There are a variety of antennas available 
for this radio.  At least one needs to be selected from the antenna patch panel and 
connected as there are normally none directly connected to the radio.  You may select 
from a roof mounted vertical, the Near Vertical Incident Skywave (NVIS) long wire, or 
the military surplus NVIS inverted V (Antenna Products HT-20B Antenna (AS-4096/G)) 
that is stored in the RACES shelter at Green Acres.  Please select the appropriate 
antenna for the band you wish to operate on and be sure the radio is connected to the 
correct antenna on the patch panel.  The default setting is for the roof mounted 
(HamStick) vertical. 
 
Turn on the IC-7300.  This will normally 
automatically power up the Terminal Node 
Controller (TNC) as well.  If the SCS PTC-
IIe TNC did not come on with the radio, 
turn it on now using the power switch 
toggle on the right rear of the unit. It is 
easy to feel. You are now ready to 
activate the Winlink Express software.   
 
First, what is Winlink? Winlink, or formally, Winlink Global Radio Email (registered US 
Service Trademark), also known as the Winlink 2000 Network, is a worldwide radio 
messaging system that uses amateur-band radio frequencies and government 
frequencies to provide radio interconnection services that include email with 
attachments, position reporting, weather bulletins, emergency and relief 
communications, and message relay. 
 
Winlink operates through a network of radio stations and volunteers who provide the 
infrastructure and the software to make this service possible. The network consists of 
Common Message Servers (CMS) that are connected to the internet, and Radio 
Message Servers (RMS) that are connected to the CMS via radio or internet links. 
Users can access the network via RMS stations using various modes and frequencies, 
depending on their equipment and location. 
 
Winlink uses a store-and-forward system to exchange messages between users and 
the internet. When a user wants to send a message, they connect to an RMS station 
using their radio and client software, such as Winlink Express. The RMS station 
receives the message and forwards it to a CMS station via radio or internet link. The 
CMS station then delivers the message to the intended recipient, either via another 
RMS station or via standard internet email protocols. 
 
When a user wants to receive a message, they connect to an RMS station and request 
a mailbox check. The RMS station queries the CMS station for any messages 
addressed to the user, and downloads them via radio or internet link. The RMS station 
then sends the messages to the user’s radio and client software. 
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Winlink can operate completely without the internet, using smart-network radio relays. If 
the internet connection is down or unreliable, the RMS stations can relay messages to 
each other via radio links until they reach a CMS station or the intended recipient. This 
way, Winlink can ensure reliable and resilient communication in any situation. 
 
Using the Winlink Express software is similar to using Outlook or Outlook Express.  It is 
used to prepare, send, and receive messages.  There are two primary modules, the 
Message Index module for message preparation and processing and a separate 
Terminal module for actually sending and receiving (connecting to a WinLink 2000 
(WL2K) station) messages. 
 
Once you have opened to the first screen you are ready to prepare a message for 
transmission.  Begin by selecting “File”, then “New” from the drop down menu. The 
WinLink application has an address book that has already been populated with our most 
commonly supported agencies and it will automatically open. Select the name from the 
address book you wish to send the message to by highlighting your choice and clicking 
on “OK”.  If your choice is not there, you will have to add it to the address book by 
selecting “New” from within the Address Book.  
 
A new “Address Properties” window will open for you to fill in. Use a short name such as 
first name and callsign (Bob -N7INK) or an abbreviated Agency name (i.e. SV ARC) for 
the “Name:” field. The “To:” field should contain the correct email address for the 
individual or agency (n7ink@cox.net or SVARC@XXX.org).  This next step is critical, 
you must also fill in the “Post Via:” field with “WL2K”.  Accept this address by clicking on 
the “OK” button.  This will return you to the “Address Book” to now select your address.   
 
You should now see a screen to prepare your message on.  You could also select a 
station to send a Courtesy Copy (Cc:) to using the same process as selecting your To: 
address.  Type in a “Subject:” and proceed to type the message. You can type it directly 
or import from a text file.  Once you have the message complete, Click on the icon that 
looks like a “letterbox” to post it for sending.  You are not done yet.  The window will 
close and take you back to the Message Processing window.  Your message will now 
show up in the Outbox ready to be sent.  If you have no further messages to prepare, 
click the “Terminal Window” icon (looks like a Yagi Antenna on a blue background) to 
switch to the “Terminal Window”. 
 
Caution: You must be a General Class or higher licensee or have a General Class or 
higher present as a control operator to proceed as the Winlink gateways are generally 
found in the 20M or 40M bands. We are working on installing an FM Winlink station at 
the club site. That station will be a VHF (2 Meter) RMS and available to Technician 
class operators also.  
 
The next step requires knowledge of the various WL2K Remote Message Servers 
(RMS)) as well as propagation characteristics to reach them based on time of day and 
distance. These are the essential “bridges” or “gateways” to the Internet.  Along the top 
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of the Terminal Window you will see two important pull-down windows.  One window will 
allow you to select from a drop down menu shows the callsigns of the various RMS’s 
currently available, the second shows the frequencies that the station scans for 
connection. It will also show you Path Reliability Estimate using a percent and also a 
color code (Red / Yellow/ Green) The list is updated on a regular basis. The table below 
identifies some of the US based stations. Locations identified with a “+” sign indicate 
“express stations” that restrict their connect protocols to PACTOR II (400 to 800 bps) 
and PACTOR III (1400 to 3600 bps.) Our station is PACTOR I/II/III capable. The table 
below shows a couple examples 
 

Callsign  Frequency Mode Grid Square GROUP Bearing Path 
Reliability 

AC6LS 10148 V2750 DM04WD EMCOMM 294 93 

K4DND 3568 V500 FM08TE EMCOMM 067 0 

AB0DK 14100 V2750 EN30RE EMCOM 54 4 

AJ7C 3597 V2750 DM04TA PUBLIC 293 76 

 
When you select a specific frequency to use from the second drop down window, the 
dial frequency at the bottom of the screen will show you exact frequency to dial in to 
ensure connection.  Check to see if the system is in “Handshake mode” (the two hands 
shaking icon). Press the antenna tune button on the front of the radio to be sure you 
have an appropriate SWR match for the radio. You are now ready to try to make a 
PACTOR connection. Next move your cursor to the “Green” light. It will momentarily 
turn yellow as a caution to be sure you have a clear frequency, assuming you do have a 
clear frequency, click on it.   The computer/TNC will now attempt to connect to the 
station.  If after 8-9 attempts, the connect fails and times out, you may want to try again.  
Most mailbox stations scan several frequencies so if it gets busy with another station on 
another frequency, it may not hear you the first few times you attempt to connect.  If 
after a few minutes you are unable to connect, try another station.  Remember that you 
will have to change the antenna if you select another band. I typically have had good 
luck with N0IA/FL or K4CJX/TN on 20 meters during the day.  I have also connected 
with them, TX and CA stations on 40 meters in the evening.  A little experience goes a 
long way when determining time of day and best propagation.  
 
Once you have connected, the system will auto detect what you have in the “Outbox” 
and what is waiting to send you from the system.  It will normally make the connection, 
send and receive the traffic and disconnect without further interaction.  Once it has 
disconnected, you may return to the Message window to read any new traffic.  Closing 
the application is as simple as clicking on the red “X” in the upper right hand corner. 
 
 


